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TOPIC -----------------------------------------------------------

This article is the Getting Started With Cyberdog file.
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This document provides pointers for getting the most from the Cyberdog beta
software. For more information, check Cyberdog home page on the World Wide Web:
http://cyberdog.apple.com

Overview of Cyberdog
--------------------
Cyberdog is an integrated suite of tools for the Internet that includes these
features: 

• World Wide Web browser
• E-mail reader and handlers
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• Newsgroup reader and handlers
• Gopher browser
• File transfer and remote login facilities (FTP and Telnet)
• Utilities for storing and organizing Internet information
• Security facilities

Cyberdog software integrates a set of full-featured Internet tools with a common
interface. Cyberdog's Internet Starting Point combines these tools into one
easy-to-use package, making Internet solutions simple. The Starting Point is
Cyberdog's predesigned way of using the Cyberdog tools. Because Cyberdog is
based on OpenDoc component technology, you can also use Cyberdog "parts" to
create your own documents with embedded Internet functionality, thus creating
your own Internet "starting point."

For more information about OpenDoc, see the section "Overview of OpenDoc" at the
end of this document.

Starting Up
-----------
The procedures in this document assume that, in addition to an Internet
connection, you have properly installed Cyberdog. For more information on
downloading and installing, see the Cyberdog home page on the World Wide Web:
http://cyberdog.apple.com.

Cyberdog installation places a folder named Cyberdog b2 Folder on your hard
disk. It contains these files and folders:

• Cyberdog Starting Point file
• First Notebook file
• Other Cyberdog Documents folder
• Tools folder

To use Cyberdog features, double-click the Starting Point icon in the Starting
Point folder. A screen with six buttons appears: 

• Notebook is linked to the file named First Notebook.

• Log is linked to your personal log file.

• Explore is linked to the Cyberdog Explore page on the World Wide Web, so
clicking this button connects you to the Internet.

• Search is linked to a search engine page on the World Wide Web, so clicking
this button connects you to the Internet.

• Discuss: The right-hand button is linked to your mail trays, or a setup screen
for your mail server. The right-hand button is linked to available news
servers.

Hints, Pointers, and Highlights

Some pointers of particular interest:
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• If the Cyberdog menus don't appear in the Internet Starting Point custom
document, hold down the Option key and click on any of the Starting Point
buttons to restore the Cyberdog menus.

• You can select any Internet object icon and drag it to any Cyberdog component,
such as mail or a notebook, or to the Macintosh desktop (Finder). You can also
select a text URL, for example, in a mail message or document, and drag it into
your notebook or mail.

• You can go to a URL from within a mail message by double-clicking the URL
icon.

• Mail and News use the same message and sending formats. You can include
pictures, links and attachments in either.

Creating a Notebook of Internet Resources
-----------------------------------------
You use the Notebook to create a personalized collection of Internet resources,
providing a means to quickly access the information that's most useful to you.
The Notebook is actually an OpenDoc container that holds Internet items,
including e-mail addresses, as well as addresses for Web sites, FTP sites,
Gopher sites, Telnet sites, and newsgroups. You can also use the Notebook to
save pictures and other files available on the Internet; You can also include
your newsgroups and mail trays.

Opening a notebook

To open a notebook, double-click the First Notebook icon in the Cyberdog b2
folder, or click the Notebook button that appears on the Starting Point screen.

Adding an item to a notebook

To create a notebook entry, open a notebook, then:

• Drag any Internet item with an icon and a name into a notebook.

Or:

• Select a URL text string and drag it into a notebook.

Or:

1. From the Notebook menu, choose Add Item To Notebook.

2. Type in the Internet address.

3. Click OK.

To add an item while a notebook is either open or closed:

1. From the Cyberdog menu, choose Add Selection to Notebook or Add Window to
Notebook.
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2. Follow the instructions in the dialog box to place the item in the
appropriate notebook and category.

Adding an e-mail address to a notebook

To have e-mail addresses show up in special address lists (described in the
later section on mail) add those addresses to your default notebook. Unless you
change it the default is the First Notebook.

 To add an e-mail address:

• From the Mail/News menu, choose Add E-mail Address to Notebook.

Or:

• Drag any e-mail address, such as one that appears in the address field of an
e-mail message, into a notebook.

Or:

• Drag any mailto: URL from a web page into the notebook.

Deleting an item from a notebook

You can use any of these methods to delete a notebook entry:

• Drag any notebook item to the Trash.

Or:

• Select a notebook item and press the Delete key.

Or:

• With a notebook item selected, choose Delete from the Edit menu.

Renaming a notebook item

To rename a notebook item, select the name of the item you want to rename, then
choose Rename Item from the Edit menu. (Unlike Macintosh file names, you can NOT
rename a notebook item by selecting it and typing over it.)

Organizing a notebook with categories

You can organize your Internet information by creating notebook categories. Note
that unlike folders on the Macintosh desktop, you can only make one level of
categories; you can't put one category inside another.

To create a category:

1. Choose Add Category from the Notebook menu.

2. Give the category a name.
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3. Drag in any items that you want to appear in that category. A bar shows where
the item will appear.

Creating multiple notebooks

If you save a large number of Internet items, you may find it useful to create
multiple notebooks to organize those Internet resources. For example, you might
find it useful to create a Work Notebook, a Finance Notebook, a Kids' Notebook
and a Hobbies Notebook. You can create as many notebooks as you wish.

No matter how many notebooks you have, Cyberdog recognizes just one default
notebook. Unless you specify otherwise, Cyberdog uses First Notebook as the
default. These are the differences between the default notebook and the other
notebooks:

• The only e-mail and newsgroup addresses that show up in address lists are
those that you store in the default notebook. (See the section on mail or more
information.)

• If you add an item to a notebook using the Add Item… menu command, the default
notebook is preselected in the dialog box that lets you choose the notebook to
which you're adding the item.

• The Notebook button in the Cyberdog Starting Point window is linked to your
default notebook.

To create a new notebook:

1. Open a notebook.

2. From the Document menu, select New.

Setting the default notebook

Cyberdog uses First Notebook as the default. To specify a different default
notebook:

1. Open the notebook that you want to make the default.

2. From the Notebook menu, choose Set Default Notebook.

Renaming a notebook

Renaming a notebook (including the First Notebook) is just like changing the
name of any other file on the Macintosh. To rename a notebook:

1. In the Cyberdog Tools folder, select the notebook you want to rename.

2. Press Enter to highlight the name.

3. Type in the new name for the notebook.
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Opening multiple notebooks

To open multiple notebooks:

1. While in Cyberdog, setup a default notebook if you have not already done so
(see earlier section). You must have a default notebook set for this to work.

2. Close all Cyberdog windows so that Cyberdog quits.

3. Launch the non-default notebook by double-clicking on it from the Finder.

4. Once that has opened, use the Show Default Notebook menuitem in the Cyberdog
menu to open the default notebook you set earlier.

IMPORTANT Do NOT open multiple notebooks by double-clicking on more than one
notebook icon or by using the Open menuitem in the Document menu. Each notebook
you open this way requires additional random access memory (RAM), which can
cause your computer to run out of memory.

Deleting a notebook

To delete a notebook:

1. If you are deleting the default notebook, be sure to set a new default
notebook, as described in the previous section "Setting the Default Notebook,"
before deleting the old one.

2. Close all Cyberdog windows. (This step applies to the b2 version of Cyberdog,
but won't be necessary in later releases.)

3. Drag the notebook to the Trash.

Using the Log
-------------
The Log is a record of Internet sites you've visited, including Web sites, FTP
sites, newsgroups, and picture and text files. You can drag items from the Log
to a notebook and to the Macintosh desktop.

Cyberdog automatically updates the Log, keeping track of each site you visit.
When you disconnect and then reconnect to the Internet, the Log from previous
sessions is maintained. The Log holds up to 200 entries, dropping the oldest
entries drop off the end of the list.

You can sort items in the Log by any of these methods:

• name (alphabetical), with items in alphabetical order

• time (chronological), with items in chronological order from most recent to
oldest. If you go to a particular site more than once, only one item shows up in
the Log.

• navigation path (hierarchical), which gives a categorical grouping according
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to the Internet server and path name. This view gives the server name at the top
of each category, then lists sites within that server.

Deleting a Log entry

Cyberdog automatically adds entries to the Log, but you can delete any Log
entries at any time. To delete entries:

1. Click the Log button in the Starting Point window.

2. Scroll to the Log entry you want to delete and select it. To select multiple
items, hold down the Shift key as you click each item.

3. Press the Delete key or choose Clear from the Edit menu.

Exploring the Internet
----------------------
The Cyberdog Internet Explorer page contains basic information about "surfing"
the World Wide Web, plus links to Internet sites that the Cyberdog team finds
especially appealing. There's also a link to information about the Cyberdog
team,

To connect to the Cyberdog Internet Explorer page, click the Explore button in
the Starting Points window. A small opening window and moving dog icon appear,
indicating that your computer is in the process of connecting. The message next
to the icon indicates which phase of the connection is in progress. To cancel
the connection, click the dog icon.

When enough information has arrived, the window expands to full size and
displays the Cyberdog Internet Explorer page.

Searching for Information on the Internet
-----------------------------------------
The Search button in the Cyberdog Starting Point window connects you to the
Cyberdog Internet Search page on the World Wide Web. This page offers a choice
of different search engines. The typical search engine lets you enter one or
more words, or "strings," then searches for instances of that word in all the
Internet sites it can find. This particular engine searches only World Wide Web,
Gopher, FTP services, and newsgroups; it does not search mail.

Receiving and Sending Mail
--------------------------
With Cyberdog, you can embed any file inside your messages, open files and URLs
from inside messages, and automatically sort and filter mail. Cyberdog also
provides the same message and sending formats for both e-mail and newsgroups.
E-mail and newsgroups use common headers and text areas that behave
consistently, and both allow styled text and embedded objects.

Setting Up Mail

In order to use Cyberdog mail, you first need an Internet mail account that uses
the POP (for receiving mail) / SMTP (for sending mail) protocols. Your Internet
service provider can give you the information you need to setup this up.
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To check whether Cyberdog mail is already set up, in the Cyberdog Starting Point
window, click the button on the right above Discuss (the button with the
mailbox). If you have already been using a mail application with mail
preferences already set up in Internet Config, such as Eudora, Cyberdog opens
the Mail Trays window and displays an In Tray corresponding to that Internet
mail account. You don't need to take any further steps to set up mail.

If Cyberdog prompts you to use the Connect To command from the Cyberdog menu, or
if there is no In Tray in your Mail Trays window, you need to set up mail.

To set up Cyberdog mail:

1. In the Cyberdog Starting Point window, click the button on the right above
Discuss (the button with the mailbox).

2. From the Cyberdog menu, choose Connect To.

3. Fill in the information in the Mail dialog box.

4. Click OK. Cyberdog sets up information for the mail account, and opens the In
Tray window for that account.

5. From the Edit menu, you can choose Cyberdog Preferences and enter your
preferences for receiving mail and working with messages.

Setting up additional accounts

If you have multiple mail accounts, follow the steps in the previous section to
set up an In Tray for each mail account.

Downloading and reading mail

To download mail from your Internet mail server:

• From the Mail/News menu, choose Check Mail. Cyberdog connects to the mail
server and immediately downloads any messages.

Or, to download mail automatically:

1. In the Mail Trays window, select the desired In Tray.

2. From the Trays menu, choose Account Info.

3. In the dialog box that opens, specify whether you want mail downloaded at
specific time intervals, or whenever the In Tray is opened.

Sending Mail

To compose and send a mail message:

1. From the Mail/News menu, choose New Message.
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Or:

Open a received message and click the Reply button or the Forward button at the
top of the message window.

Or:

Double-click an e-mail address that you saved in a notebook or on the Macintosh
desktop, or click a mail URL on any World Wide Web page.

2. Type in your message. You can embed any file by dragging it in to the text
area of a message. You can use any font or color of text you choose, but keep in
mind that the recipient's mail application might affect the look of your
message.

3. You can create mail stationery by saving the message using the Letterheads
menuitem in the Message menu. The information in the message, such as
letterhead, favorite URLs, and frequently-used addresses automatically appears
whenever you later select this file in the Letterhead dialog that opens when you
request a new message.

4. From the Message menu, choose either Send Now or Send Later. Send Now causes
Cyberdog to immediately connect to the mail server and send your message. Send
Later places the message in the Out Tray but doesn't send it until you select
Send Now at some later time.

5. Close the message. Cyberdog prompts you to indicate whether you'd like to
save the message as a file on your Macintosh.

Sorting and filtering mail
--------------------------
If you send or receive large amounts of mail, you can use Cyberdog mail handlers
to simplify and streamline your mail processing. For example, you can use a mail
handler to automatically direct all mail from the University of California in to
your UC mail tray. Or, you can have Cyberdog place all messages with "Australia"
or "Travel" in the subject in your Vacation mail tray.

To set up mail handling, choose Mail Handlers from the Mail/News menu. In the
dialog box appears, you can define what parts of the mail message you want
Cyberdog to look at, and specify the mail tray that you want to receive a
particular type of mail (be sure to create any personal mail trays you might
want to filter mail to before you setup your mail handlers).

Searching through mail messages
-------------------------------
You can search through all your messages for particular text or information. For
example, you may want to collect together all the messages about a certain topic
(say, "Our Trip to Hawaii"). Even if these have been saved in different folders,
the search facility will find all messages containing, say, the text "Hawaii"
and list them for you.

To search through your mail messages:
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1. From the Mail/News menu, choose Search in Messages.

2. In the Search dialog box that appears, specify which trays to search in, what
text to look for, or a received date.

The search returns a "relevance-ranked" list, which means that the more times
the criteria you specified were found in a message, the higher that message will
be in the list.

Reading Newsgroup Articles
--------------------------
Cyberdog is preconfigured to connect to some newsgroups of general interest.

To view the articles within a newsgroup:

1. Click the News button above the Discuss label.

2. Click the triangle to display the list of newsgroups that are already
available.

To follow a discussion in a newsgroup, drag the item from the Newsgroup window
in to your notebook. Your notebook will keep track of the messages you've read.
Be sure to save your notebook. Note that if you read newsgroups in your
newsgroup window instead of from your notebook, each time you close the window
Cyberdog loses track of which messages you've read.

Subscribing to additional newsgroups
------------------------------------
To subscribe to a new newsgroup:

1. Choose Connect To from the Cyberdog menu.

2. Fill in the server information. This can be a URL (Web address).

3. Select Choices. The newsgroup appears in the Newsgroups window.

To subscribe to individual newsgroups, drag them from the window to your
notebook.

Sorting and filtering news articles
-----------------------------------
You can use handlers to sort and filter mail messages, much the same way as you
can sort and filter e-mail. This enables you to filter out articles that you
don't want to read.

To set up a news handler:

1. From the Mail/News menu, choose Create News Handler.

2. Select the news group or discussion you want the handler to apply to.

3. From the Mail/News menu, select Apply to Selection.
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If you want display articles you've already read, or articles that you've
filtered out, select Display Read or Display Unwanted Items in the Trays menu.

Handlers will work automatically each time you open a newsgroup. Note that only
handlers that apply to that newsgroup or to All newsgroups will be used to
filter in that particular group.

Searching newsgroups
--------------------
You can use the Search button on the Starting Point screen to search newsgroup
titles, but not the content of individual articles within a newsgroup. After you
enter the Search command, Cyberdog displays all the groups that match your
search criteria. You can save the newsgroups that interest you by dragging them
to a notebook.

Overview of OpenDoc
-------------------
Although you don't need to know anything about OpenDoc to use Cyberdog, this
section provides a brief introduction for you if you're interested in the
software architecture that underlies Cyberdog.

OpenDoc is Apple's new component technology for object embedding. OpenDoc
changes your experience of the Macintosh in three main ways: 

• Object embedding
OpenDoc allows computer objects, such as pictures, command buttons, and even
windows, to be embedded inside other objects. The Cyberdog Starting Point
window, which appears when you first launch Cyberdog, is an example of a
container document with embedded buttons, which are OpenDoc parts. The title is
an embedded picture, the six buttons are embedded "cyberbuttons," and the button
labels are embedded text.

• Interchangeable software parts
Each of Cyberdog's main parts (listed in the previous section, "Overview of
Cyberdog") is a piece of software that is fully interchangeable with other
"Cyber-savvy" software. As more parts become available from Apple and other
developers, you will be able to drop other Internet facilities into Cyberdog and
use them seamlessly in combination with what's already there.

• User interface changes
These OpenDoc changes to Macintosh menus show up in Cyberdog: 

• the Document menu replaces the File menu
• the Close command replaces the Quit command
• menus change depending on which part is active

For more information about OpenDoc, check this site:

http://opendoc.apple.com

Copyright 1996, Apple Computer, Inc.
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